
NI ELVIS III 
Getting Started

2023-09-18



Contents
Getting Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3

Setting up Your Device. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
What You Need to Get Started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  3
Installing and Powering the Hardware. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
Connecting the Device to Your Host Computer. . . . . . . . . . . . . . . . . . . . . . . . . . . . .  8
Configuring the Device. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14

Setting up the Host Computer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  19
Installing the Measurements Live Support Files. . . . . . . . . . . . . . . . . . . . . . . . . . .  20
Installing the NI ELVIS III Software Bundle. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  20

Using the Device. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Launching the Soft Front Panels. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  21
Creating an NI ELVIS III Application. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

ni.com2

NI ELVIS III Getting Started



Getting Started
The getting started guide provides step-by-step instructions on how to connect the
NI ELVIS III hardware, launch the Soft Front Panels (SFPs) from Measurements Live,
and develop applications on the NI ELVIS III using the NI ELVIS III Software Bundle.

If you are a... Where to go

Student
■  Getting Started with Measurements
Live
■  Creating an NI ELVIS III Application with
LabVIEW
■ Programming the NI ELVIS III with
Python or C

Note If your lab administrator has
not set up the hardware and
software for you, set up your device
and the host computer first.

Lab administrator Guide for Lab Administrators—Instructs you to
set up lab devices, computers, and servers.

Professor Act as a lab administrator or refer to Teaching
with NI ELVIS III.

Setting up Your Device
This section provides step-by-step instructions on how to connect and set up the
NI ELVIS III workstation.

■  What You Need to Get Started
■  Installing and Powering the Hardware
■  Connecting the Device to Your Host Computer
■  Configuring the Device

What You Need to Get Started
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To set up and use the NI ELVIS III, you need the following items:

■ Required hardware

■ NI ELVIS III workstation
■ AC/DC power supply
■ High-speed USB 2.0 cable
■ Computer

■ Recommended items for first time users

■ BNC to BNC cable or
■ Cables and Accessories Kit (786520-01)

■ Optional items and tools for further exploration

■ NI ELVIS III prototyping board
■ Components to build your circuits
■ Cabling and sensors as required for your application
■ Wire cutter
■ Wire stripper

■ Software

■ NI ELVIS III Software Bundle Installer (optional)

■ Documentation

■ NI ELVIS III Quick Start Guide
■ NI ELVIS III Safety, Environmental, and Regulatory Information (SERI)
manual

Unpacking Your Device
The NI ELVIS III workstation and the NI ELVIS III Prototyping Board ship in antistatic
packages to prevent electrostatic damage. Electrostatic discharge can damage
several components on the NI ELVIS III hardware.

Notice Never touch the exposed pins of connectors.
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To avoid such damage in handling the workstation and prototyping board, take the
following precautions:

■ Ground yourself using a grounding strap or by holding a grounded object.
■ Touch the antistatic package to a metal part of the computer chassis before
removing the workstation or prototyping board from the package.

Remove the hardware from the package and inspect it for loose components or any
sign of damage. Contact NI if the hardware appears damaged in any way.
Store the workstation and the prototyping board in the antistatic envelopes when
not in use.

Tip Go to Installing and Powering the Hardware next.

Installing and Powering the Hardware
Before you set up and use the NI ELVIS III device, ensure that you have the required
items listed in the What You Need to Get Started section.

1. Ensure that the power switch at the back of the NI ELVIS III workstation is
switched off.

2. Connect the power supply.
3. Connect the Wi-Fi antenna and/or relevant cables based on the following:

a. For initial configuration and launching of the Soft Front Panels without
network access or programming, start with Connecting to the Device via
USB.

b. For Ethernet connection configuration, start with Connecting to the
Device via Ethernet.

c. For wireless connection (Wi-Fi models only) configuration, start with
Connecting to the Device via Wireless Network (Wi-Fi models only).

Note The USB cable is also required for the initial
configuration of the wireless network.
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a. Power supply cable
b. Device USB cable (required for initial configuration)
c. Ethernet cable (optional connection)
d. Wi-Fi antenna (Wi-Fi models only)

4. Plug the power supply into a wall outlet and switch on the power switch at the
back of the NI ELVIS III workstation.

5. Ensure that the application board power button on the workstation is turned
off. The integrated LED in the power button should not be lit.

6. Install the NI ELVIS III prototyping board (or compatible application boards) as
shown in the following figure:
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a. Position the opening in the NI ELVIS III prototyping board over the
application board mounting bracket.

b. Slide the edge connector of the NI ELVIS III prototyping board into the
receptacle on the workstation and ease it into place.

7. Secure the NI ELVIS III prototyping board to the workstation using two M4
mounting screws as shown in the following figure:
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8. Power on the application board power button on the workstation. The
integrated LED in the power button should be lit. The four Fixed User Power
Supplies LEDs on the prototyping board should also be lit.

Notice When you turn on your device and connect it to the network,
certain device data (serial number, device ID, MAC address, IP address,
Hostname, used hardware and software versions) is transmitted in
encrypted format to NI. This information will be deleted after you remove
your device from the network, for example, by turning it off or switching
off the Ethernet or Wi-Fi (Wi-Fi models only) functionality. The only
exception is when the device is configured for infinite lease time and/or
infinite grace period, in which case the serial number and device ID will be
stored for this purpose only. Accessing the above data is necessary to
establish the connection and transmit communication between the
devices connected to the Measurements Live network and the instrument
soft front panels in Measurements Live, access to which is provided with
the product. NI does not store or use this data for any other purposes.
Because the above information, in particular the device ID, may be
available for others connected to the network, providing any personal
information by setting your device ID or otherwise will be at your sole risk
and responsibility. NI is not responsible for the behavior of any other
device users connected to the network. If you do not want to share the
above data with others in the Measurements Live network, you should not
use the network functionality of your device. You can still use your device
with your computer through a USB connection.

Tip Go to Connecting the Device to Your Host Computer next.

Connecting the Device to Your Host Computer
You can connect the NI ELVIS III to your host computer using one of the following
methods:

■  Connecting to the Device via USB
■  Connecting to the Device via Ethernet
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■  Connecting to the Device via Wireless Network (Wi-Fi models only)

Connecting to the Device via USB
Complete the following steps to use a USB cable to connect the NI ELVIS III from the
USB device port to your host computer.

1. Connect the Type-C to Type-A USB 2.0 cable to the NI ELVIS III as shown in the
following figure:

2. Connect the other end of the USB cable to the host computer.

Notice Ensure that the host computer is powered on before
connecting the USB cable.

If the connection is successful, you can see the IP address of the USB connection on
the OLED display of the NI ELVIS III after you install the Measurements Live Support
Files. Press and hold the user programmable button (Button 0) on the left-hand side
of the NI ELVIS III workstation until you turn on the display. The IP address of the
USB connection appears after the  icon.
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Note The device does not need an ID when connected via USB. The OLED
display returns ID not available when you connect the device via USB
only.

Tip Go to Setting up the Host Computer to set up the software
environment.

Tip Go to Configuring the Device if you need to upgrade the software on
the device or set up an administrator password.

Connecting to the Device via Ethernet
Complete the following steps to use an Ethernet cable to connect the NI ELVIS III to
your host computer.

1. Connect the Ethernet cable to the NI ELVIS III as shown in the following figure:

2. Ensure that the Ethernet cable is connected to a router that is set up correctly.

ni.com10

NI ELVIS III Getting Started



Note Your host computer and the NI ELVIS III needs to be
connected to the same subnet (local network).

NI ELVIS III Local NetworkHost Computer

Router

If the connection is successful, you can see the IP address of the Ethernet
connection on the OLED display of the NI ELVIS III. Press and hold the user
programmable button (Button 0) on the left-hand side of the NI ELVIS III workstation
until you turn on the display. The IP address of the Ethernet connection appears
after the  icon.

Tip Go to Setting up the Host Computer to set up the software
environment.

Tip Go to Configuring the Device if you need to upgrade the software on
the device or set up an administrator password.

Connecting to the Device via Wireless Network (Wi-Fi models only)
Complete the following steps to connect the NI ELVIS III to your host computer via a
wireless network.

1. Connect the Wi-Fi antenna to the NI ELVIS III as shown in the following figure:
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Note The USB cable is also required for the initial configuration of
the wireless network.

2. Configure a wireless network on the NI ELVIS III.

Configuring a Wireless Network on the Device

Note The following steps are required for initial configuration only. The
NI ELVIS III automatically connects to the wireless network that it has
connected to before.

1. Use a USB cable to connect the NI ELVIS III to your computer, as explained in
Connecting to the Device via USB.

2. In Internet Explorer, enter http://<USB IP address>/WIF.html in the address
bar to launch the System Configuration page. To view the IP address of the
USB connection, press and hold the user programmable button (Button 0) on
the left-hand side of the NI ELVIS III workstation until the OLED display on the
workstation is lit. The IP address of the USB connection appears after the 
icon.
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Note
■ You must use Internet Explorer to complete this step.
■ The IP address of the USB connection appears only after you
install the Measurements Live Support Files.

3. Click the Network Configuration button  on the left

of the web page to display the Network Configuration page.

4. In the Wireless Adapter wlan0 section, select Connect to wireless
network from the Wireless Mode pull-down menu.

5. Select the country in which you are located from the Country pull-down
menu. You must specify a country before you can select an available channel
for the wireless network.

6. Select the wireless network you want to join or select Other network if
you cannot find the wireless network from the Wireless Network pull-down
menu.

7. Enter security settings for the wireless network that you select. You must
select Infrastructure from the Network Type pull-down menu because the
NI ELVIS III does not support Ad Hoc networks.

8. Select DHCP or Link Local from the Configure IPv4 Address pull-down
menu. This option specifies that the NI ELVIS III automatically acquires an IP
address.

© National Instruments 13

NI ELVIS III Getting Started



9. Click Save to save the settings.

If the connection is successful, you can see the IP address of the wireless network
connection on the OLED display of the NI ELVIS III. Press and hold the user
programmable button on the left-hand side of the NI ELVIS III workstation until
you turn on the display. The IP address of the wireless network connection appears
after the  icon.

Tip Go to Setting up the Host Computer to set up the software
environment.

Tip Go to Configuring the Device if you need to upgrade the software on
the device or set up an administrator password.
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Configuring the Device
In most cases, you do not need to configure the NI ELVIS III. The NI ELVIS III ships
with the recommended software installed and necessary configurations made. You
may need to configure the NI ELVIS III in cases such as upgrading the software on it
or setting up an administrator password.

To configure the software on the NI ELVIS III, you will need to use Measurement &
Automation Explorer (MAX).
This tutorial contains instructions on completing the most common configurations
for the NI ELVIS III using MAX:

■  Installing Software on the Device—This topic tells you how to upgrade the
software on the NI ELVIS III or reinstall the software on the NI ELVIS III after you
reformat it.
■  Updating Firmware on the Device—This topic tells you how to upgrade the
firmware on the NI ELVIS III.
■  Securing the Device—This topic tells you how to protect your lab devices by
setting administrator password and permissions.

For more information about configuring the NI ELVIS III using MAX, refer to the
LabVIEW Real-Time Target Configuration section of the Measurement &
Automation Explorer Help which you can launch by selecting Help » MAX Help in
MAX.

Tip Go to Setting up the Host Computernext.

Installing Software on the Device
The NI ELVIS III ships with the recommended software set installed on the device.
You can use Measurement & Automation Explorer (MAX) to upgrade or modify the
software set, or reinstall the software set after reformatting the device.

Note MAX is installed automatically when you install the NI ELVIS III
Software Bundle or the LabVIEW ELVIS III Toolkit.

Complete the following steps to install software on the NI ELVIS III using MAX:
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1. In MAX, expand Remote Systems in the configuration tree and then expand
your NI ELVIS III target.

2. Right-click Software and click Add/Remove Software to launch LabVIEW
Real-Time Software Wizard.

Note If MAX prompts you to log in, enter admin in User name and
leave Password blank if you have not set a new password. Refer to
Securing the Device to learn how to set a new password for the
device.

3. Select the recommended software set for the NI ELVIS III.

4. Click Next.
5. Ensure that LabVIEW ELVIS III Toolkitx is selected, where x matches the version

of the LabVIEW ELVIS III Toolkit.

6. Click Next to view a summary of your selection.

7. Click Next to start installing the software. When the installation completes,
the wizard restarts the NI ELVIS III.

8. Click Finish to close the wizard.

Tip Go to Setting up the Host Computer to set up the software
environment.

Tip Go to Updating Firmware on the Device to update the firmware.

Updating Firmware on the Device
The NI ELVIS III ships with required firmware. You can use Measurement &
Automation Explorer (MAX) to update the firmware.

Note MAX is installed automatically when you install the NI ELVIS III
Software Bundle or the LabVIEW ELVIS III Toolkit.
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Complete the following steps to update firmware on the NI ELVIS III using MAX:

1. Obtain the latest firmware file by installing the latest NI ELVIS III Software
Bundle.

2. In MAX, expand Remote Systems in the configuration tree.

3. Click the NI ELVIS III target, and click the Update Firmware button in the
System Settings section.
MAX automatically navigates to the latest firmware file for the NI ELVIS III.
Firmware files for the NI ELVIS III are named ELVISIII_<version number>.cfg.
For example, ELVISIII_6.0.0.cfg.

4. Click Open.

5. Click Begin Update to update the firmware.

Note If MAX prompts you to log in, enter admin in User name and
leave Password blank if you have not set a new password. Refer to
Securing the Device to learn how to set a new password for the
device.

You can verify the version of the firmware currently installed on the NI ELVIS III in the
System Settings section.

Tip Go to Setting up the Host Computer to set up the software
environment.

Tip Go to Securing the Device to prevent unauthorized users from
changing system configuration.

Securing the Device
If you are a Lab Administrator, you can prevent unauthorized users from changing
system configuration on the NI ELVIS III by setting an administrator password and
permissions in MAX.
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Note MAX is installed automatically when you install the NI ELVIS III
Software Bundle or the LabVIEW ELVIS III Toolkit.

Setting a New Password
By default, each remote device includes a single user with the following name and
password:

■  User name: admin
■  Password: <blank>

Complete the following steps to set a new password.

1. In MAX, expand Remote Systems in the configuration tree and then select
your NI ELVIS III.

2. Login with the default user name and password:

a. Click Log In on the toolbar.

b. Enter admin in User name and leave Password blank.

c. Click OK.

3. Click Set Permissions on the toolbar to launch the Security Configuration
page in a browser.

4. Enter admin in User name and leave Password blank.

5. Double-click admin in the list of users under the Users tab.

6. Enter a secure password in New Password.

7. Re-enter your password in Re-type New Password.

8. Click Save.

9. Click Upload Changes to save the changes to the system.

You can now return to MAX and log in using the new password.
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Note NI cannot recover lost system passwords. If you forget the
password, you must contact NI and reformat the NI ELVIS III.

Removing Permissions from the Everyone Group
To secure your device, your must also remove all permissions from the everyone
group.

1. Click Set Permissions on the toolbar to launch the Security Configuration
page in a browser.

2. Enter your user name and password. Enter admin in User name and leave
Password blank if you have not set a password.

3. Click the Groups tab.

4. Click the everyone group.

5. Select all permissions in the This group has the following permissions
section and click Remove to remove all the permissions.

6. Click Save to save the change.

Tip Go to Setting up the Host Computer next.

Setting up the Host Computer
According to the task you want to perform with the NI ELVIS III, set up the software
environment on your host computer.

What you want to do Where to go

Use the Soft Front Panels (SFPs) to control an
NI ELVIS III in a web browser and do not need to
program the NI ELVIS III with LabVIEW.

Zero installation! Go directly to
measurementslive.ni.com.

Use the SFPs when not connecting your device
to the Internet.

Installing the Support Files

Use the Logic Analyzer and Pattern Generator.
Program the NI ELVIS III with LabVIEW. Installing the Software Bundle
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Tip Go to Using the Device next.

Installing the Measurements Live Support Files
You can either download the Measurements Live Support Files from ni.com or
access the offline installer stored on your NI ELVIS III USB drive.

Downloading the Online Installer
You can download and install the Measurements Live Support Files from ni.com.

Accessing the Offline Installer
Complete the following steps to access the offline installer stored on your NI ELVIS III
USB drive:

1. Use a USB cable to connect the NI ELVIS III to the host computer, as illustrated
in Connecting to the Device via USB.

2. On your host computer, navigate to the icon that represents the NI ELVIS III
USB drive.

3. Open Start Here.html and follow the instructions on the screen to install the
Measurements Live Support Files.

You can now launch the SFPs from Measurements Live.

Tip Go to Launching the Soft Front Panels for using Soft Front Panels to
access and control the Instrument I/O without programming.

Tip Go to Installing the Software Bundle for installing necessary software
to control the Instrument I/O programmatically.

Installing the NI ELVIS III Software Bundle
The NI ELVIS III Software Bundle includes the main software you need to build
embedded applications for the NI ELVIS III, including LabVIEW, the LabVIEW Real-
Time Module, the LabVIEW ELVIS III Toolkit, and Multisim.
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Download the NI ELVIS III Software Bundle from ni.com/academic/download.
Apart from the required LabVIEW software to develop applications, you may also
need to install some of the optional software based on the type of the application
you want to create:

■ To customize the FPGA on the NI ELVIS III, install the LabVIEW FPGA Module.
■  To create applications that are controls specific, you may need to install
additional NI software products, such as the LabVIEW Control Design and
Simulation Module.

To verify that you have successfully set up a programming environment, you can
create a simple application to control an onboard device on the NI ELVIS III.

Tip Go to Creating an Application next.

Using the Device
This section provides step-by-step instructions on how to access and control the
instruments on the NI ELVIS III by using the Soft Front Panels (SFPs), and how to
program the I/O on the NI ELVIS III by using the NI ELVIS III Software Bundle.

■  Launching the Soft Front Panels
■  Creating an Application

Launching the Soft Front Panels
You can launch the instrument Soft Front Panels (SFPs) from Measurements Live.
To open Measurements Live, go directly to measurementslive.ni.com. After you open
Measurements Live, follow the onscreen instructions to connect to the NI ELVIS III
and launch the desired SFP.

Note If you want to use the Logic Analyzer and Pattern Generator (Logic)
or connect to the NI ELVIS III via USB, you must first install the SFPs to your
host computer. Open Measurements Live from your Windows desktop or
macOS Launchpad.
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Using Measurements Live, you can connect to and control the NI ELVIS III anywhere
and from any device that has internet connection. For example, you can open
Measurements Live from your smart phone and control an NI ELVIS III in the school
lab to generate a sine waveform. Note that you need a real-time device ID to
establish the connection between your device and the NI ELVIS III. Lab
administrators can set up a custom signaling server to allow students to get the
device ID remotely.
By default, the SFPs stay in the same browser window, which allows you to view and
configure all open SFPs in one place. You can change the layout of the SFPs by
dragging and dropping them to the positions you want. You can also open an SFP in
a separate browser window if you want to focus your work on one single SFP.
If you are using Measurements Live for the first time, read through the following
sections to find answers to commonly raised questions.

How Do I Rearrange My SFPs?
You can rearrange the SFPs within the browser window to get a better layout. Click
the  icon on the top left side of an SFP and drag and drop it to the position you
want. Large SFPs such as the Oscilloscope are always located to the left of small
SFPs such as the Variable Power Supplies (VPS). Your window size decides whether
the SFPs are arranged vertically or horizontally.

How Do I Open an SFP in a Separate Window?
If you want to focus your work on one single SFP, click the  icon on the top left
side of the SFP and then click . The SFP pops up in a separate browser window.
To restore your SFP to the original window, close the SFP and launch it again.

How Do I Save My Data?
You can export data and take screenshots for all open SFPs simultaneously by
clicking the buttons on the top right side of Measurements Live. Note that you
cannot export data when the SFPs are running. For SFPs opened in separate
windows, you must save their data respectively.
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Why Can't I Export Certain Types of Files for an SFP?
Refer to Data Import and Export for detailed information about the file types that
each SFP supports.

Using the Soft Front Panels
This topic provides an example of using the Function and Arbitrary Waveform
Generator (FGen/Arb) and the Oscilloscope to generate and display a waveform.

1. Connect a BNC - BNC cable between the Oscilloscope CH 1 and the Function
Generator CH 1 BNC connectors on the NI ELVIS III as shown in the following
diagram:

2. Select Function and Arbitrary Waveform Generator from the Instruments tab
in Measurements Live.

3. On the FGen/Arb SFP, configure Channel 1 as follows:

Setting Value

Channel 1 Static
Waveform Sine
Frequency 100 Hz

Amplitude 2 Vpp
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Setting Value

DC Offset 0 V

4. Click Run to start the FGen/Arb.

5. In Measurements Live, select the Oscilloscope SFP from the Instruments tab.
6. On the Oscilloscope SFP, configure the Oscilloscope as follows.

Setting Value

Time/div 5 ms

Channel 1 On
Volts/div 1 V

Probe attenuation 1x

Coupling DC
Vertical offset 0 V

7. Click Run to start the Oscilloscope.
You should see a 100 Hz sine wave on the Oscilloscope display. Adjust the
settings of the FGen/Arb and observe the changes of the waveform on the
Oscilloscope display.

User Programmable Button
The user programmable button on the left-hand side of the NI ELVIS III workstation
serves two purposes. It aids in connecting the NI ELVIS III to your host computer, and
you can programmatically monitor it in a LabVIEW RT or LabVIEW FPGA application.

Display

Button 0

ni.com24

NI ELVIS III Getting Started



Pressing and holding the button enables the OLED display, which shows the current
device ID and IP addresses for the NI ELVIS III. This functionality is always active,
even if an application is programmatically monitoring the button.
You can also programmatically monitor the button in your application to trigger or
control other events. You can acquire the values from the button by using the Button
Express VI in an RT application or by using the FPGA I/O node in an FPGA
application.
The following figure shows an example of using the Button Express VI, which is
highlighted, to monitor the button and display the current state using a Boolean
indicator. When you press the button, the Boolean indicator of the VI returns TRUE.

Note Take care when you press and hold the user programmable button
to display the device ID and IP addresses. If a running VI is monitoring the
button, it cannot differentiate between a button press intended to enable
the display and a press intended to trigger an action by the application.
Pressing and holding the button enables the display and triggers the
programmatic action simultaneously.

Creating an NI ELVIS III Application
This tutorial explains how to create an NI ELVIS III application using the NI ELVIS III
Software Bundle. It guides you through creating a project, building the block
diagram, and running the application.

■  Creating an Project
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■  Programming the Control I/O

Note This tutorial does not require the NI ELVIS III Prototyping Board.

Creating an NI ELVIS III Project
Before programming with the NI ELVIS III, you must first create an NI ELVIS III
project. With an NI ELVIS III project, you can group together all the files relevant to
your application and run VIs on the NI ELVIS III.
Complete the following steps to create an NI ELVIS III project by using the NI ELVIS III
Project template.

1. Click Create New Project in LabVIEW to display the Create Project dialog
box.

2. Select Templates » NI ELVIS III from the project category.

3. Select NI ELVIS III Project from the project list.
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4. Click Next to configure details of the new project.

5. In Project Name, enter My First ELVIS III Application.

6. In Project Root, enter the path to the directory for saving the project.

7. (Optional) In File Name Prefix, enter a prefix that distinguishes different
copies of templates you create.

8. Under Target, select the NI ELVIS III on which to run your application.

9. Click Finish. LabVIEW saves the project and opens the Project Explorer
window.

10. Explore the Project Explorer window. For example, expand items in the
project tree to find Main.vi. Refer to the Project Documentation folder for
detailed information about the NI ELVIS III project.
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Project Explorer Window
Use the Project Explorer window to manage the NI ELVIS III project you have
created.
You can use the Project Explorer window to complete the following tasks:

■ Managing the targets, VIs, and other support files of a project from one
location.
■ Connecting the host computer to the targets, setting target properties, and
deploying VIs to targets.

The following figure shows the Project Explorer window when you add the
NI ELVIS III and its chassis to a LabVIEW project. To add a chassis, right-click the
NI ELVIS III target in the Project Explorer window and select New » Targets and
Devices. Locate the chassis you want to add and click OK.

The Project Explorer window includes the following components:

■  Project root—Contains the host computer and the NI ELVIS III you add to
the current project. To add more targets to the project, right-click the project
root and select New » Targets and Devices from the shortcut menu.
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■  My Computer—Represents the local or host computer as a target in the
project.

■  Build Specifications—Includes build configurations for source
distributions and other types of builds available in LabVIEW toolkits and
modules.

■  RT Target—Represents the NI ELVIS III you add to the project. VIs and
libraries that you add to the NI ELVIS III appear under the target in the Project
Explorer window.

■ FPGA Target—Represents the FPGA target on the NI ELVIS III.
■ Build Specifications—Includes specifications for building source
distributions, stand-alone real-time applications, and zip files.

Tip Go to Programming the Control I/O next.

Programming the Control I/O
In this part of the tutorial, you start from a project that monitors the user
programmable button on the NI ELVIS III, and extend its functionality to control the
user programmable LEDs.
Before starting this part, make sure you have completed the steps to create an
NI ELVIS III project.

1. In the Project Explorer window of your NI ELVIS III project, open the Main VI. By
default, LabVIEW opens the front panel of the Main VI. The front panel is the
user interface of a VI.

2. Press <Ctrl-E> to switch to the block diagram of the Main VI.
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The block diagram contains the graphical code of a VI. The Main VI contains a
Button Express VI which reads the Boolean value from the user programmable
button and displays the changes of the Boolean values in the LED on the front
panel. The Main VI uses a Flat Sequence structure that contains several
subdiagrams. Refer to Structures for more information about the structure of
the Main VI.

3. Select View » Functions Palette to display the Functions palette. You can
also right-click on the block diagram to display the palette. Navigate to
Functions » Academic I/O » Control I/O to locate the LED Express VI.

4. Drop the LED Express VI in the Main Loop of the Main VI by clicking the LED
Express VI and then clicking on the block diagram.
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5. Double-click the LED Express VI in the Main Loop to display the configuration
dialog box. In the configuration dialog box, press <Ctrl-H> to display the
Context Help window. You can move the cursor over options in the
configuration dialog box and learn basic information about the options from
the Context Help window. Most objects in LabVIEW display context help
information.

6. Select the LEDs to control and click OK to apply your configuration. This
tutorial teaches you to control all the user programmable LEDs.
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7. Right-click each input of the LED Express VI and select Create » Control to
create Boolean controls for the LEDs. You can click a Boolean control on the
front panel to toggle between the TRUE and FALSE states, which determines
the ON and OFF states of an LED.
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8. Press <Ctrl-E> to switch to the front panel of the Main VI. Arrange the Boolean
controls from left to right.
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9. Click Run. The Deployment Progress window appears, which shows the
status of the deployment of the Main VI on the NI ELVIS III.
After the deployment is complete, you can toggle the Boolean controls and
observe the state changes of the LEDs.

10. Click Stop.

11. Click File » Save to save the VI.
You have successfully created a VI that controls the user programmable LEDs.
Before you proceed to the next step, spend some time understanding the
following LabVIEW programming concepts:

■  Structures
■  Error Checking

Structures
Structures are graphical representations of the loops and case statements of text-
based programming languages.
The block diagram of the Main VI contains a Flat Sequence structure, which contains
one or more subdiagrams, or frames, that execute sequentially. You can use the Flat
Sequence structure for more advanced applications that require sequential
execution of subdiagrams. The Flat Sequence structure in the Main VI executes the
following frames from left to right:
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• Initialize—Initializes the error in cluster. You can add more code to initialize the
NI ELVIS III, variables, and user interface elements, such as controls and indicators,
depending on your application needs.

• Acquire and process data— Acquires the boolean value from the button on the
NI ELVIS III and displays the value by using the Button indicator. The Main Loop
repeats code until you click Stop or an error occurs.

• Close— Resets the FPGA target and all the I/O channels on the NI ELVIS III before
the application exits. You can also use this frame to close user interface elements
and variables.

Tip Go to Error Checking next.

Error Checking
Error checking identifies why and where errors occur in your VI.
The current Main VI checks errors in the Button Express VI. If the Button Express VI
returns an error, the Main VI stops.
The yellow wire that comes into and out of the Button Express VI is the error wire.
The error wire passes the error cluster value, which contains three elements: status,
code, and source.

■  status is TRUE if an error occurred.
■  code is the error or warning code.
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■  source specifies the origin of the error or warning and is, in most cases, the
name of the node that produced the error or warning.

The Unbundle By Name function, which is highlighted in the figure, returns the
status element in the error cluster. If the Button Express VI returns an error, status is
TRUE, and the Boolean value is passed to the Conditional Terminal, also
highlighted. When Conditional Terminal receives a TRUE value, the Main Loop stops
repeating the code within its diagram, and the Main VI stops.
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To ensure that the Main VI also stops when the LED Express VI returns an error, you
must add code to check errors in the LED Express VI. Use the Merge Errors function
to merge errors from the Button and LED Express VIs. You can access the Merge
Errors function by navigating to Functions » Programming » Dialog & User
Interface » Merge Errors.
The following figure shows the block diagram after you add the Merge Errors
function, which is highlighted. The Main VI stops if the Button Express VI or the LED
Express VI returns an error, or if you click Stop on the front panel.
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